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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site for New Zealand. You can store 
your issues of MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from macOS 10 Mavericks onwards, which means you end up 
with a reference library you can search, highlight, add notes to etc) and have it appear on your iPhone and iPad (inside iBooks) next time you sync. Or print it out, even – and please feel free 
to pass MagBytes on. MagBytes is free to receive and you can opt out any time by sending an email here with ‘opt out’ in the subject line. The email list is guarded and private and held by 
Mac NZ for this purpose only. Find out more about the MagBytes Apple newsletter online (click on ‘MagBytes Newsletter’ at top right).

May 2017  
•2——WWDC ~ What it means  

•3——Mac News ~ WannaCrypt, 
accessibility, Astrophysicist, 
desktop pictures, Touch Bar 

award, Lattice Data  
•5——Updates ~ macOS 10.12.5, 

tvOS 10.2.1, iOS 10.3.2,  
watchOS 3.2.2, Sonnet USB-C 

•7——Mac Help ~  
Around New Zealand 

•8—— iOS & iDevice news 
~ iPhone loyalty, Jamf, Indian 
SE, iPhone vids, Hearing Aid, 

enabling iPhone, 7 ad 
•10——Apple & Talk ~ Apple & 

puck, Microsoft & new worlds  
•12——Tips & Tricks ~ 

Calendar, iCloud, iOS and 
watchOS, Safari on Mac, Back to 

my Mac and a Mac medley 
•19——How To ~ Mac NZ &  

how to use it

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

The World Wide Developers’ Conference is in San Jose this year instead of San Francisco 
(image from Apple’s WWDC Developer page)
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OK  it’s WWDC on the New Zealand 6th June
Yes 6th June is D-Day indeed. The Apple Worldwide Developers 
Conference (WWDC) was first held 26 years ago. The conference 
has stayed true to its original theme of 
becoming a one-stop destination for 
programmers and users to showcase and 
peruse new technologies and software 
from the Cupertino-based tech giant. It 
also drives the tech press into a frenzy. 
This annual conference cum convention 
is targeted specifically for software 
developers but is used to showcase 
what Apple is doing and intends doing, and was often famously 
conducted by Steve Jobs. Last held June 14-17, 2016, attendance 
is capped, only available by lottery and very quickly sells out, 
sometimes in seconds.
Apple announces new operating systems (usually the full ones 
introducing significant features, ie a macOS 10.13 rather than a 
10.12.6, which would be a bug-fix , a couple of new features and 
security update) but also new products: iPhone was introduced 
at WWDC, the Mac Pro, iOS 10, iPad etc. Press attendance is 
gathered from all over the world. 

What does WWDC mean for us?
Over here in New Zealand, we call WWDC 
‘DubDubDeeCee’. Apple’s annual Worldwide 
Developers Conference always means a few things: Apple 
always announces, and sometimes even releases, new products. 
Widely expected are new Macs, new MacBooks (hopefully 
with the better, newer Kaby Lake Intel CPUs) and perhaps the 
announcement of the very hotly anticipated iPhone 8, which will 
signify ten years since Apple introduced the first iPhone, which 

World of Apple > WWDC means new products, services ... who knows?

has changed the entire world. 
When new Macs and iPhones, and perhaps even iPads, are 
announced, the retail chain tries to divest itself of existing 

products, so either way, it’s a great time to buy: Apple 
rarely drops prices even a little, but this happens to the 
back catalogue, and the new releases normally come 
out at the same price point as models they supersede, 
but with advanced features. 
Win win.
But ... that does mean for goodness sake don’t 
make a significant purchase until you have seen 

what Apple announces on the US 5th, and NZ’s 6th, June. 

WWDC rumours of  this & that ...
You may have noticed I have not been publishing speculations 
about what Apple will announce and/or release, but many others 
have. \
The NZ Herald has fallen into the trap of publishing what Apple 
‘will’ release at WWDC but all we have had are rumours, since 
we don’t know what Apple will release at WWDC until ... Apple 
releases them at WWDC.  

The NZ Herald has actually been doing 
worse: reprinting verbatim speculations 
from other agencies as if they are facts. 
Shame on you! 
Readers, here’s my advice: wait till Apple 

tells you what’s coming out, because then you’ll actually know. 
Clear and simple.

If  you’re really keen to see what Apple announces
Go to www.mac-nz.com first thing on Tuesday 6th June in New 
Zealand.

mailto:mac.nz%40me.com?subject=From%20MagBytes
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Mac News > WannaCrypt and Mac users, Apple and global accessibility

Avoiding WannaCrypt 
OK, you’re part way there already if you’re 
using an Apple device, as they’re immune. 
But you can pass on the malware, even 
in the form of an email with a link to it, 
to a contact using Windows on a Mac 
or PC. For some Mac users need or have 
to run Windows on their machines, and 
not all our friends have seen the light (of 
Apple). If you’re only an occasional user of 
Windows on a Mac, make sure you don’t 

More news is online at Mac NZ

get hit by the current worms. WannaCrypt 
a problem for Windows users, but the 
worm/virus combination could hit a 
Mac user with a Boot Camp partition or 
Windows virtual machines in VMware 
Fusion, Parallels, or other software. 
If you fit that bill and haven’t booted your 
Windows system since mid-March or you 
didn’t receive or install Microsoft’s vital 
security update (MS17-010) released at 
that time, read on.

It’s critical that you don’t start up a 
Windows XP or later installation that’s 
unpatched and let it connect.

Accessibility Awareness Day
This was May 18, and Apple released 
the Designed for Everyone video series. 
Apple has a long history of working to 
make open accessibility a key feature 
of its hardware products and software 
development platforms. For Global 

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.mac-nz.com
http://www.istorenz.com
http://www.techconnect.com/article/3197144/security/how-to-avoid-the-wannacrypt-virus-if-you-run-windows-on-a-mac.html?idg_eid=166a4564ed7fcfab4737a147b0a6cc4f&email_SHA1_lc=a8af31c195e59706e0b780d58597de11e8f609a3&cid=tcon_nlt_techconnect_daily_2017-05-17
http://www.techconnect.com/article/3197144/security/how-to-avoid-the-wannacrypt-virus-if-you-run-windows-on-a-mac.html?idg_eid=166a4564ed7fcfab4737a147b0a6cc4f&email_SHA1_lc=a8af31c195e59706e0b780d58597de11e8f609a3&cid=tcon_nlt_techconnect_daily_2017-05-17
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Mac News > Astrophysicist, desktop pictures, Touch Bar award, Lattice Data

Accessibility Awareness Day, Apple 
posted a series of seven videos to YouTube 
showing how real people make use of Mac, 
iOS and Apple Watch accessibility features 
from Switch Control to Siri to VoiceOver. 
Each tells the story of specific individual in 
about two minutes.

Sign language keyboard overlay
These covers work with all US, European, 
UK and Rest of World keyboards. They 
are designed to not slip or slide and 
have a smooth feel comfortable to the 
touch while presenting keys you need, 
simultaneously protecting your keyboard 
from dust, sneezes and minor spills. 
The Sign Language cover costs US$29 and 
fits the 13-inch MacBook Pro with Touch 
Bar, 13-inch MacBook Pro without Touch 
Bar 2016+, 15-inch MacBook Pro with 
Touch Bar and the Apple Magic Keyboard.

Mac-using Astrophysicist
Dr Kelly Holley-Bockelmann is an 
Associate Professor of Physics and 
Astronomy at Vanderbilt University. Her 
research speciality is black holes and 

gravitational waves and she uses a Mac 
and supercomputers to study how black 
holes generate ripples in the fabric of 
spacetime and deepen our astronomical 
understanding and perspective. Kelly, her 
students and associates are also devoted 
Mac users, and she tells John Martellero 
why.

Alternative desktops on Mac
Here’s how to find them. These images 
are all 3200 pixels by 2000 pixels, to work 
nicely for most resolutions.

‘Beyond WWDC’ Events
Apple has posted some of the third 
party events (which it has not done 
before) that take place during its own 
World Wide Developer Conference. The 
Apple Developer Connection has a new 
Beyond WWDC list that includes events 
like AltConf 2017, The Talk Show with John 
Gruber Live, CocoaConf Next Door, Layers, 
the App Camp for Girls benefit with James 
Dempsey and the Breakpoints, and Jim 
Dalrymple’s Beard Bash.

MacBook Pro Touch Bar Award
It may be a controversial Mac, but the 
MacBook Pro with Touch Bar won a Display 
Industry Award from the Society for 
Information Display (SID), a professional 

organisation 
focused on the 
display industry. The 
awards are granted 
to “display products 
that incorporate 
the most significant 
technological 
advances and/
or outstanding 
features.”

Lattice Data
Apple has acquired 
Lattice Data, a 
company that 
applies an AI 
enabled inference 
engine to take 
unstructured, “dark” 
data and turn it 
into structured 
(and more usable) 
information for 
about $200 million. 
The deal was closed 
a couple of weeks 
ago, and about 
20 engineers have 
joined Apple. Lattice 
was born of the 
DeepDive project. 

More news is online at Mac NZ

mailto:mac.nz%40me.com?subject=From%20MagBytes
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macOS 10.12.5
Apple squashed 30 security holes in macOS Sierra with the 
release of macOS 10.12.5. The company’s security notes indicate 
the update addressed a wide variety of issues in its Mac operating 
system, many of which are serious. Flaws would have allowed 
the bad guys to capture network credentials, gain root control 
of your Mac or read data stored in memory that is supposed to 
be protected. It also apparently solves problems with stuttering 
audio from USB headphones, and allows ‘media-free’ installation 
of the Windows 10 Creators Update using Boot Camp, according 
to official release notes. The 10.12.5 update can be installed free 
via the Mac App Store.

Apple launches tvOS 10.2.1
The operating system for the Apple TV has reached version 10.2.1. 
The operating system was recently revved to version 10.2, which 
provided an accelerated scrolling feature to the Siri remote to 
scroll through lists of content faster. The update also added 
the TV app, which is designed to offer a unified experience for 
discovering and accessing TV shows and movies from multiple 
apps on the iPhone, iPad, and Apple TV.  It provides one place to 
access TV shows and movies, as well as a place to discover new 
content to watch.
To install, launch the System menu and choose Software Update. 
(tvOS 10.3 may be previewed at next month’s WWDC.) 

Apple releases iOS 10.3.2
iOS 10.3.2 offers bug fixes, security enhancements and other 
improvements. It’s a free over-the-air update available to all 
users with a compatible iPad, iPhone or iPod touch. It can also be 
downloaded and installed on plugged-in iOS devices via iTunes on 
a Mac or PC.

Updates > macOS 10.12.5, iOS, watchOS and tvOS; Sonnet Echo Express SE III 

watchOS reaches version 3.2.2
Apple has revved watchOS to 3.2.2 
focussing on bug fixes and performance 
improvements to the Apple Watch’s 
operating system.
The previous release (watchOS 3.2) added 
Theater Mode and SiriKit. The former 
lets Apple Watch owners disable the 
“rise to wake” function on the watch, but 
still notify them with haptic feedback of 
notifications without illuminating the 
watch display.
watchOS 3.2.2 must be performed through 
the Apple Watch app on a connected 
iPhone, and the watch must be on the 
charger, and have over 50 percent battery 
remaining.

Sonnet Echo Express SE III
Sonnet Technologies has announced the 
launch of the Echo Express SE III, the 
newest member of the company’s Echo 
Express family of Thunderbolt-to-PCI 
Express (PCIe) expansion systems. With 
full support for Thunderbolt 3 (aka USB-C), 
the Echo Express SE III is a compact 
desktop device that enables the use of up 
to three high-performance PCIe cards with 
Thunderbolt 3 Macs. 
The Echo Express SE III is expected to be 
available May 22 at a suggested retail price 
of US$499.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macobserver.com/news/product-news/apple-squashes-30-security-holes-macos-sierra-plus-standalone-updates-el-cap-yosemite
https://www.appleworld.today/blog/2017/5/11/2scj8oe8125zhdp4ez7pgx8cr3ikll
http://www.sonnettech.com/product/echoexpressse3.html
http://www.macsense.co.nz
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USB-C to USB Cable
Power and charge any USB-C device (ie, MacBook, late 2016 
MacBook Pro) using a regular USB charger. Supports USB 3.1 
Gen 1 data transfer speeds of up to 5 Gbps, Moshi’s USB-C 
to USB Cable is encased in aluminium with reinforced stress 
relief points and includes a HandyStrap cable manager
NZ RRP$44.99

IonGlass for 
iPhone 7
IonGlass is an atomically-
strengthened glass screen 
protector featuring 
smooth, edge-to-edge 
protection with a micro-
bevel around the Home 
button for fast unlocking 
via Touch ID. Its exceptional 
hardness exceeds that of 
steel. 
NZ RRP$59.99 
(iPhone 7 Plus, NZ$69.99)

USB-C to VGA adapter
Output HD video from any USB-C device or laptop 
to a VGA display or projector. Moshi’s VGA adapter 
supports video resolution up to 1920 x 1200/1080p 
at 60Hz. Both ends of the cable are encased in 
anodised aluminium to minimise electromagnetic 
interference. With its reversible USB-C connector 
and plug-n-play capability, the adapter guarantees a 
hassle-free setup for convenient home or office use
NZ RRP$69.99

USB-C Charge Cable
Smart LED indicators keep track of your charging 
status. Supporting up to 60 Watts of power output 
and USB 2 data transfer speeds, Moshi’s USB-C 
Charge Cable has durable aluminium housings and 
delivers utility and style for anyone with an Apple 
Retina MacBook, Google Chromebook Pixel, or 
any mobile device equipped with a USB-C port. At 
2 metres length (6.6 feet) in length, a HandyStrap 
is also included to keep your cable neat and tidy 
during transport 
NZ RRP$59.99

armour for iP-
hone 6-7
The armour features a 
diamond-cut aluminium 
backplate with a unique 
metallic finish, the 
hybrid material has 
shock absorption and is 
scratch resistant. It has 
fully-encased volume and 
power buttons and the 
raised bezel protects the 
display and the case offers 
military-grade drop-
protection (MIL-STD-810G, 
SGS-certified)
NZ RRP$64.99

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
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https://www.macgear.co.nz/collections/moshi/products/moshi-ion-glass-for-iphone-7-plus
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https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-charge-cable-2m-1
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Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Also try Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. Every new 
Mac has a one-year warranty and 90 days 
free phone support. AppleCare extends 
this all out to three years. Under NZ 
law, you are covered by the Consumer 
Guarantees Act against anything going 
wrong that comes down to parts failure 
within reasonable expectations (say, inside 
three years’ use), but be prepared to spend 
anxious time on the phone, sticking to 
your guns to get it fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 
If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.
Eden Roskill — This Auckland branch has 
an Apple Group that meets on the second 
Monday of every month at 487 Dominion 
Rd in the Mt Eden Senior Citizen Rooms, 
opposite Potter’s Park in Balmoral. There 
are several courses for Apple users (Mac, 
iPhone and iPad) as numbers warrant. To 
join, call Janet 09 828 3098

Mac & iDevice training in 
Auckland 
You’re getting MagBytes and may be 
following my weekly Friday tips on Mac 
NZ, so that’s quite a lot of free help. 
I can and do one-to-one or small group 
sessions at your home or workplace in 
Auckland. This costs $95/hour but I’m 
now only available for this on Mondays 
and Tuesdays, since I work at a museum. 
I can present to institutions on Mac and 
iDevice: tips, tricks, hidden features, 
demystification ...Email Mark for info.

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top), but the first 
thing you can do is open the Utilities folder 
on your Mac’s applications folder, and find 
Apple’s Disk Utility. Launch it, select your 
Mac’s internal hard drive which is normally 
called ‘Mac HD’ (or plugged in hard drive/
flash drive/camera card etc) and run First 
Aid over it. (iDevices are another story!)

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
MacNorth Computers 09 433 9855,  
027 490 2332, or email Dave Boswell.

Mac Help > Apple assistance, Consumer Guarantees Act, help, support

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
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iDevice news

Logitech ad

iPhone at 92% loyalty 
A new study published by 
investment bank Morgan Stanley 
shows 92% of iPhone users who are 
“somewhat or extremely likely” to 
upgrade within 12 months intend 
to buy Apple, a good indicator 
that this year’s iPhone revamp has 
the makings of a so-called “super 
cycle.”

Jamf ‘Safe Passage’
Jamf has announced a “safe 
passage” program for schools 
and organizations considering 
migrating to the company’s Apple 
management solutions. Trusted 
by over 10,000 organizations, 
including 4000 K-12 schools, 
1000 universities and over 5000 
businesses, Jamf provides a path 
for customers considering a new 
mobile device management (MDM) 
solution.

Indian iPhone SE
The Wall Street Journal says 
Apple has confirmed that its 
manufacturing partners in India 
have started domestic production 
of the iPhone SE. Previously, Apple 
produced most of its smartphones 

> Super Cycle iPhone, Jamf iDevice management, Indian SE

More news is online at Mac NZ
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iDevice news> Shootin’ with iPhone, iPhone hearing aid, life-changer, Barber

iPhones in China with a few older models 
assembled in Brazil.
Apple has tapped Taiwan’s Wistron 
Corporation to put together the 
smartphones in the tech capital of 
Bangalore in Karnataka.

16 ‘Shoot with iPhone’ Videos
Apple  launched a site dedicated to 
its Shoot with iPhone 7 instructional 
videos on YouTube. They on Friday, Apple 
published a sub-site on the apple.com 
domain with 16 videos from the series.
It’s a slick, well-produced site with a 
gorgeous landing video. Below that video 
is a grid for the 16 videos the company has 
so far released for the series. Hover over 
one of those cells and the name of the 
video is replaced by an example.

Hearing Aid Pro for iPhone
One of the ‘badges of honour’ that comes 
along with advancing years is hearing 
loss. Whether it’s medically-caused, the 
result of too many years of listening to 
loud music, or just plain old age, almost 

everyone gets to the point that their 
hearing isn’t as sharp as it used to be. 
Hearing Air Pro (NZ$14.99/US$9.99) is 
designed to act as a hearing aid that runs 
on your iPhone. It uses the mic in your 
earbuds as input and amplifies it, using 
some smartness, into the buds. 

Quadriplegic’s iPhone enables
Todd Stabelfeldt has been paralysed from 
the shoulders down since a gun accident 
severed his spinal cord, leaving him 
confined to a wheelchair as a quadriplegic. 

More news is online at Mac NZ

But using iOS Switch Control, Todd gained 
new abilities and independence through 
accessible technology. And now, using 
HomeKit and Siri, his entire home has 
become accessible.

Barbers iPhone 7 ad
Apple has shared a new iPhone 7 Plus 
ad on its YouTube channel, once again 
promoting the Portrait Mode feature of its 
flagship device.
The spot takes place in a barbershop, with 
photos from the iPhone 7 Plus.
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apple&talk > Apple is really entranced with that puck

Every technology 
company of any merit 
maps out a technological 
road ahead, garners 
resources to reach that 
point, then heads for it. 
A lot of what’s achievable, 
of course, depends on 
what tech is available, ie 
with Intel CPUs, port tech, 
bus chips etc.
Apple, perhaps thanks to 
undue influence allowed 
to Jony Ive, staked its 
future on the Touch Bar – 
which I agree is much better than a touch 
screen on a PC – and slimmer and lighter 
at any cost, but pro users yearned for more 
RAM (32 GB), more CPU/GPU speed, and a 
longer battery life, as the Mac Observer’s 
John Martellero pointed out.
And if you wonder why gaming is so 
important to computing, gamers want 
exactly the same things, so both these 
markets drive computer development, and 
of the two, gamers is probably the bigger. 
In the old saw of ‘skate to where the 
puck will be, not where the puck is’, 
Apple is now the puck, and the other 
tech companies – even dinosaurs like HP 
and Microsoft – have skated past. Oddly, 
Apple’s new Park’ even looks like a puck!

Of course, the counter argument runs 
that Samsung ‘discovered’ the secret to 
selling smartphones was to copy Apple’s 
software as closely as possible. Microsoft 
did the same thing, reckons Daniel Eran 
Dilger, in reverse: using its own software, 
it began copying Apple’s hardware 
business as closely as it could, which I 
find ironic after the decades of Microsoft 
aficionados berating me that ‘Apple didn’t 
know what it was, a software or hardware 
company’.
(Hah, sucks to be you, now.)

Apple has the resources to build a fully 
functioning base on the moon, as I’ve 
said before, and still have the billions upon 

billions to improve its 
offerings with. Yet still 
we wait. A lot can go 
wrong with the hopes 
for an iPhone sales 
comeback starting in 
late 2017 with iPhone 
8, aka the tenth 
anniversary iPhone. 
People these days hold 
onto their existing 
smartphones for 
longer (I’m still more 
than happy with my 6, 
and there have been 

several models since then). Meanwhile 
a higher percentage of people buying 
iPhones in the US, still Apple’s biggest 
market, have been opting for older or 
cheaper models than they did in the past.
Of course, there are 500 to 600 million 
iPhones out there in the world. If just 4% 
of those iPhone owners opt for a new 
model, that translates into at least 20 
million new iPhone sales. As Shira Ovide 
asserts, if the iPhone/smartphone has run 
out of growth, it’s not clear that driverless 
cars, streaming videos, ‘smart speakers’ or 
anything else can fully pick up the slack.

But still, Apple – the puck’s going to be 
somewhere else. Where will you be?

Apple’s new corporate headquarters (image from 9to5 Mac)
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apple&talk > Microsoft and the New Worlds awaiting us

Did you know Microsoft is expanding its 
presence on Apple’s iOS 10 messaging 
platform with a new iMessage App 
designed to allow groups to search 
for movies, food, events and other 
entertainment options and vote on what to 
do? Does this surprise you?
It shouldn’t. Despite public posturing to 
the contrary, which hit its apogee under the 
madly gesticulating Steve Ballmer (thank 
goodness for his great replacement, CEO 
Satya Nadella), Apple and Microsoft have 
had a long and very rewarding relationship, 
with engineering teams collaborating on 
each other’s campuses for decades.

Apple uses Microsoft networking 
protocols; Microsoft embraces Apple 
video and audio standards. Microsoft Office 
works beautifully on Mac and iOS, and 
in fact, to my eyes, benefits from Apple’s 
superior (-looking) OS and monitor tech. 
And even Apple’s macOS has only had little 
updates over the last couple of years – 
meanwhile Microsoft is developing a future 
OS that will combine standard 2D display 
tech with 3D/holographics, VR and AR. This 
is called Fluent Design.
I guess we will see if Apple has any vision in 
this area … one day.
Meanwhile, Microsoft recently released 
its dev platform Visual Studio for macOS. 

Chipping, chipping, chipping away, 
combining hardware with software in ways 
that only Apple ever really pulled off. 

This is reasonable, sensible and 
productive. It’s how adults should behave, 
right? I think so.  However, lately Microsoft 
has been making hardware, something 
it has almost never 
done, barring Xbox. 
In fact, Windows 
fans used to laugh 
at Apple because 
Apple made hardware 
as well as software. 
Then Microsoft made 
some awful products 
like that cack-coloured 
music player and the Windows Phone. Yuk.

But now, Microsoft is making the 
hardware that even Apple fans can be 
impressed by, while Apple fiddles while 
watching its hardware house burn down. 
Apple’s products are still beautiful, sexy, 
slim, minimalist … and obsolete, lagging 
generations behind other computers. Pro 
Mac users want and need their Macs to be 
grunty, and nothin’ else! They’ve got to the 
point where looks are secondary because 
Apple needs so desperately to up the 
computational power of its pro machines.

Some, unfortunately, have given up 
already – will they come back? We used 
to run stories about ‘switchers’ who had 
dumped Windows for macOS and couldn’t 
be happier.
Now there are even rumours that Apple 
is planning a new ‘pro’ iMac “designed to 

compete with Microsoft’s 
Surface Studio all-in-one 
PC“…

WHAT? That’s pure 
heresy right there! 
Also, Apple isn’t in the 
Virtual Reality space 
yet. There’s supposedly 

an Apple lab in wellington 
pursuing this, and Apple has made various 
VR acquisitions, but Apple’s hardware isn’t 
up to VR – Oculus dropped support for the 
Mac in 2016 because it wasn’t powerful 
enough. The only thing Apple seems to 
excel at now is 4K display support, but 
Windows is catching up fast.
Once we looked cool and progressive with 
our Apple gear.
Now we look like sad holdouts.

Anyway, it’s WWDC soon (New 
Zealand’s June 6th). Apple, will announce 
stuff. But I remember saying that last year 
… and the year before …
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> Apple’s Calendar app and iCloudtips&tricks
1/ Edit appointment details using the 
Calendar Inspector in macOS Sierra 
— The Inspector window appears when 
you add a new event, or double-click on 
an existing event in the Calendar app in 
macOS Sierra, or click and event once and 
choose Command-e.
Inspector shows you all the details of your 
events, including who’s invited, and where 
and when you want the event to occur. 
Start typing an address and Calendar 
suggests matching locations. Start typing 
the name of a contact in your Address Book 
and Calendar suggests matching names 
based on contacts you’ve entered in the 
Contacts app.
You can even see your event locations 
on a miniature map in the Inspector. (If 
you click this mini map, the Maps app 
opens a full size view.)  The mini map 
includes an estimate of the travel time to 
your appointment destination from your 
current location in the event Inspector as 
well as the weather forecast for that day. 
(For travel time estimates, directions and 
weather, you need to turn on Location 
Services in System Preferences.)

2/ Use your iCloud account in macOS 
Sierra’s Calendar app — iCloud is included 
with macOS. Once you sign up for your 

free iCloud account, you can push calendar 
updates across your devices, share your 
iCloud Calendar, and see your calendar on 
the iCloud website.
If you have an iCloud account , you can 
use iCal to access and manage your iCloud 
calendars. If you set up the iCloud Calendar 
service on several devices and computers, 
your iCloud calendar and reminder 
information is kept up to date on each 
device and computer.
Set up your iCloud calendar account from 
System Preferences to see your iCloud-
based calendars in the Calendar window. 
In the System Preferences app, click iCloud 
and sign in.
If this is your first time signing in from this 
computer, you’ll be asked if you want to 
use iCloud for contacts, calendars, and 
bookmarks. Make sure that the calendars 
option is selected (checked), then click 
Next.
If you’ve previously signed in to iCloud, 
you’ll see a list of iCloud services – select 
the check-box next to Calendars to have 
them sync.

3/ Add calendars to macOS Sierra’s 
Calendar from other services besides 
iCloud — You can use your iCloud account 
in macOS Sierra’s Calendar app to add 

an event, and this appears as if by magic 
on all your other Apple devices linked to 
that same Apple ID. But you can also add 
appointments from other popular services 
to your calendar in Calendar app, including 
Exchange, CalDAV, Facebook, and Yahoo:
Choose Apple Menu > System Preferences.
Select Internet Accounts.
Click the Add Account (+) button at the 
bottom of the window.
Choose the account type you want to use, 
and enter your account credentials.
Make sure the option Calendars is selected 
(checked) to display the events associated 
with this account in the Calendar app. 
[These three Calendar tips came form the 
Apple World Today.]

4/ iCloud Drive and syncing iWork 
documents to your iOS devices — Those 
files aren’t necessarily being stored on your 
iPhone or iPad. Meaning that if you’re out 
and about, heading into a bad cell area may 
cause you to lose access to said files. Which 
is a bummer.
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tips&tricks > iCloud and Calendar ~ Three for iOS, two for Apple Watch

To check out what your situation, just open 
any of the iWork apps (Pages, Numbers, or 
Keynote) on your iOS device. When you do 
so, you’ll see a list of your documents of 
that type. If some of the files are in iCloud 
but aren’t downloaded, you’ll see a tiny 
cloud icon on those.
Of course, you can tap to download any 
one you’d like, but if what you really want is 
to keep all documents of that kind on your 
iPhone or iPad at all times, head over to 
your Settings. Scroll down until you see the 
section for the app you’d like to download 
stuff for and tap it.
Within that, look for the “On-Demand 
Downloads” toggle.
Turn that OFF, and everything you’ve got 
within that app will download so you can 
keep all your documents on your iPhone. 
This is great if you’re going on a trip 
and don’t want to use cellular data, for 
example, or if you just know you always 
need access to your spreadsheets. But be 
careful—I strongly suggest that you go into 
the app in question and make certain that 
the process has completed before you hit 
the road. You might even want to turn on 
Airplane Mode for the device and try to 
open a file or two. Paranoid? 
Heck, that’s just who I am. Almost a decade 
of tech support has traumatized taught me 
well.

5/ iSee the status of uploads in iCloud 
Drive — While we’re messing with iCloud,  
you can turn on Finder’s Status Bar, the 
option for which is under the View menu 
click on the iCloud Drive option in Finder’s 
sidebar (shown above), and suddenly you’ll 
get a lot more information about your 
uploads.
Also turn the Path Bar on (View > Show 
Path Bar, shown below). This is helpful if 
you’d like to have a trail of breadcrumbs, 
so to speak, leading back within the folder 
structure you’ve navigated through – this 
appears at the bottom of folder windows. 
Any of the location icons in the Path Bar are 
double-clickable, as well, to return you to 
someplace you’ve been. 
This is very useful if you tend to drill way 
deep down into folders and then forget 
where you came from...

1/ Make Home Button Touch ID work 
like it used to — iOS 10 brought a big 
change to the way the Home Button 
worked by requiring users to press it, 
even after your fingerprint has been 
recognised. But there’s a feature under 
Settings>General>Accessibility that 
allows you to make your Home Button 
work like it used to – it makes your iPhone 
or iPad with Touch ID unlock with just a 
touch from the lock screen.
In Settings > General > Accessibility, scroll 
down until you see the Home Button 
menu item. Tap it.
In this area, you can change the click speed 
of the Home Button, and control whether 
Siri or Voice Dictation activates when you 
press and hold. But at the bottom, you’ll 
see a switch called Rest Finger to Open. 
Tap that. Once enabled, you can open 
your iPhone with Touch ID the old way: 
just press your finger against it, instead 
of having to press it first. This isn’t a full 
return to iOS’s Slide-to-Unlock, but many 
users might find it more natural than the 
default way of doing things.

2/ Vibrate Only for certain events — On 
your iOS devices, there are settings that 
control which sounds play for which 
events, like when an email comes in or 
you get a text. with an iPhone, you can 
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tips&tricks > iOS tips continued (a mixture)

also choose for certain events to have 
no associated sounds but to vibrate your 
device instead. For me, this is really useful: 
you might like to know right away when 
you get a text, say, so you will have a 
sound associated with that, but for emails, 
no. You can set those to vibrate only 
(actually, I have email alerts turned off on 
iPhone, that way I only get them when I 
check them, which suits me better).
Open the Settings app on your iPhone, 
then tap Sounds & Haptics.
Under that section are some very useful 
choices. At the top you can configure 
whether your device will vibrate when it’s 
ringing or when it’s on silent. Scroll down 
a bit to set up which 
sounds you’d like to hear 
for which events.

3/ Backing up Voice 
Memos — Sometimes 
you can’t beat a quick 
Voice Memo to record a 
thought, tune or to-do. 
But since there is no Voice 
Memo folder in iCloud 
Drive, and while memos 
are part of your iPhone backup (and they 
also back up to iTunes on Mac./PC if that’s 
what you prefer as your backup), we can 
also make use of the share sheet put them 

somewhere specific.
You can create a folder in iCloud Drive (or 
your cloud provider of choice) for audio 
clips. For apple’s free iCloud Drive online 
storage, chick iCloud on your Mac in the 
left side of a Finder window and choose 
New Folder from the File menu. Another 
option is to create a note or folder in 
Apple Notes dedicated to voice memos.
On iPhone, go into the Voice Memos 
app, tap on a recording and hit the share 
button (shown below). From here, you 
can select Add to iCloud Drive or Add to 
Notes.
You can also straight AirDrop them. Tap 
on a recording and then the share button 

as above, make sure 
Bluetooth is enabled 
on your iPhone and 
Mac, and you can 
look for your Mac’s 
account photo under 
AirDrop.
If your audio 
recordings are large 
in size, using iTunes 
is another way to 
share. Connect your 

iPhone to your Mac, and click the phone 
symbol on the upper left. Next, click on 
Apps in the sidebar, and scroll all the way 
to the bottom until you see Voice Memos. 

You can then drag and drop your audio 
clips to any location in your Mac.

4/ Combine watchOS 3.2 ‘Theater Mode’ 
with ‘Wake Screen on Crown Up’ to 
discreetly check time on Apple Watch 
Series 2 — Here’s how to combine the 
two features. All current Apple Watch 
hardware has access to the watchOS 3.2 
update, which adds the new Theater Mode 
option in Control Center. To access it, 
simply swipe up from the bottom of the 
display on a watch face, and choose the 
icon depicting comedy and tragedy masks.
But while all Apple Watch users can 
access theater mode, the next part of 
the tip is specifically limited to Series 2 
hardware. Since the second-generation 
hardware debuted last September, it has 
exclusively offered a new feature known 
as Wake Screen on Crown Up. To enable 
this feature, open the Apple Watch app 
on a connected iPhone, choose General, 
and then Wake Screen. By default, new 
Apple Watch Series 2 units ship with Wake 
Screen on Crown enabled.
Theater Mode prevents your Apple Watch 
display from lighting up when your wrist 
is turned, which can be annoying in a dark 
movie theatre, for example. Users must 
instead tap the display in order to check 
the time.
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tips&tricks > Apple Watch                                       ~ Safari on Mac

However, when Wake Screen on Crown Up 
is enabled, users can also slowly brighten 
the display by turning the Digital Crown. 
As the digital crown is rolled forward, 
the Apple Watch Series 2 screen becomes 
gradually more visible, allowing users to 
keep the light from their watch dim – a 
particularly handy feature for politely 
checking the time without bothering 
others, while in a movie theatre or at a 
play.
After checking the time, users can either 
roll the Digital Crown back to dim the 
display to dark, or simply wait three 
seconds for the screen to auto-darken.
If you roll the Digital Crown further 
upwards, the display will become fully 
“on,” at the normally set brightness, and 
will not automatically dim as long as 
your wrist is facing you. In this situation, 
simply turn your wrist away from you as 
you normally would, and the display will 
automatically shut off. With Theater Mode 
enabled, the screen will not automatically 
turn back on regardless of orientation.
(If you want to be extra polite while at the 
movies, you can also create a low-light 
watch face that will make the display 
even less noticeable. Simply create a new 
Modular face, set it to red (which helps 
preserve night vision), and disable all its 
watch face complications.)

5/ Reining in watchOS — You don’t have 
to automatically Install Apple Watch 
Apps. Some of the apps that go along 
with it may not be that relevant to you. 
Depending on when you set up your 
wearable device, it may automatically 
install all new apps to the Apple Watch. 
You don’t have to automatically install 
Apple Watch apps. Apple Watch has a 
limited amount of storage space, and any 
music and photos you have take up some 
of it, so you may want to limit how many 
apps you install. Second, not all Watch 
apps are incredibly useful and you might 
find yourself wanting to get rid of them.
Open the Watch app on your iPhone
Scroll down and tap General
Flip the toggle switch next to Automatic 
App Install so it is no longer green
Remove the Apps You Don’t Use
With Automatic App Install off, you might 
want to clear out apps you aren’t using. 
Return to the My Watch screen, and scroll 
down until you see your list of third-party 
apps. If you see Installed next to an app, 
it’s already there. Tap on the apps one at 
a time. You’ll see a toggle switch for each 
labelled Show App on Apple Watch. Flip 
that switch so it’s no longer green. Apple 
Watch will uninstall that app. When you 
come across an app you do want to install, 
just flip that switch to green to install.

1/ Recover lost tabs and windows 
in Safari — Some users have a lot of 
Safari tabs open all the time. For some 
folks, open tabs are apparently a way 
to remember to follow up on things or 
purchase items. It’s much more sensible to 
use Bookmarks but hey, we’re all different. 
But if you close a tab and didn’t mean to, 
the menu item to recover them is under 
History at the top of your screen.
Within that menu (above), you will see 
Recently Closed, which will show you tabs 
and windows you may have dismissed 
accidentally. Click any single item to 
reopen that one page.

2/ Reopen Last Closed [Window/Tab] 
— This does just what it says, and Reopen 
All Windows from Last Session, which is 
handy if Safari didn’t restore your tabs 
after it was quit for whatever reason. 
(These options may look a little different 
or say slightly different things depending 
on exactly how many tabs you closed, for 
example, but if you’re looking to get back 
what you lost, this History menu is very 
handy.
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tips&tricks > iCloud files and Back to my Mac

Of course, if all you want is to undo 
accidentally closing a tab right after you 
did it, you’d just press Command-Z like you 
would anywhere else in any Mac operation 
to undo your last action.  You can also 
press this key combo multiple times to get 
back several tabs if you went on a closing 
frenzy and then came to your senses.

3/ Uploading files from a browser via 
iCloud — Log into iCloud.com on the 
computer you’d like to upload files from. 
Head to Photos if you want to upload 
images to your iCloud Photo Library or 
iCloud Drive for all other types of files.
In either place, you’ll see an Upload 
button at the top of your browser window 
(indicated above). Choose that, and you’ll 
get the familiar file-picker dialog box, 
from which you can navigate to the items 
you’d like to upload.
How long your upload will take is 
dependent on the size of the file(s) you 
select and your internet speed. If you 
signed in to your iCloud account on a 
machine that isn’t yours, make sure to log 
out before you walk away.

The beauty of this trick is most apparent 
if you’re using iCloud Photo Library or the 
Mac’s Desktop and Documents syncing 
feature. In the case of photos, for example, 
anything you upload to iCloud.com will 
be immediately distributed to all of your 
devices if that syncing is turned on.
For iCloud Drive, though, whatever folder 
you’re looking at online will be where 
the files you upload end up. So you could 
navigate to iCloud.com, open iCloud Drive, 
double-click to view your Desktop folder, 
and then upload files there. When you get 
back to your Mac, you’ll see the stuff you 
uploaded, already on your Desktop and 
ready to go. [From the Mac Observer.]

4/ Connect to a remote Mac in your Back 
to My Mac network with macOS Sierra — 
With macOS Sierra’s Back to My Mac, you 
can connect to your other Macs securely 
over the Internet. This is an iCloud feature 
that lets you set up a network of Macs 
that you can access remotely.  After you 
set up each Mac or AirPort base station, 
you can connect to it remotely.
From the Finder menu, choose 
Preferences, and click the Sidebar tab.
In the Shared section, select Back to My 
Mac.
Open a Finder window, and look for the 
Shared section in the sidebar. If you don’t 

see any shared computers or base stations, 
place the pointer over the word Shared 
and click Show.
Select the remote computer or base 
station that you want to access and click 
Connect As. (To share a screen with your 
remote Mac, select the Mac and click 
Share Screen.) If you don’t see the Mac or 
base station that you’re looking for, click 
All to see a list of available Mac computers 
and base stations.

5/ Remove a Mac from your Back to My 
Mac network on macOS Sierra — You 
can turn off Back to My Mac whenever 
you want (here’s how you set it up). When 
you do, you’ll remove that Mac or AirPort 
base station from your Back to My Mac 
network.
Follow these steps:
Choose System Preferences from the  
menu, then click iCloud.
In iCloud preferences, deselect Back to My 
Mac to turn it off. You also can click Sign 
Out to log out of iCloud completely.
To remove a base station, follow these 
steps:
From the menu bar, choose Go > Utilities 
and double-click AirPort Utility.
Select the AirPort base station that you 
don’t want to use anymore, and click 
Edit. If you don’t see the base station, 
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click Other Wi-Fi Devices to see a list of 
available base stations. You might need to 
choose a different Network Interface from 
the pop-up menu.
Enter the base station password. This 
password is different from your iCloud 
password.
Select the Base Station tab.
In the Back to my Mac section, click the – 
(minus) button and enter the Apple ID you 
use with Back to My Mac. The green status 
indicator should disappear, showing that 
Back to My Mac is turned off.
Click Update to save your changes.

1/ Set up and use Back to my Mac in 
macOS Sierra — If you have an iCloud 
account, you can use ‘Back to My Mac’ 
to connect to your other Macs over 
the Internet. You can then use Screen 
Sharing to control 
the remote computer 
from anywhere you 
are connected to the 
Internet.
(To use Back to My Mac, 
you must have an Apple 
AirPort Base Station or 
AirPort Time Capsule 
set up for NAT-PMP, or NAT Port Mapping 
Protocol, or a router set up for UPnP 
(Universal Plug and Play)

You can also share files between 
computers, including files that aren’t 
stored in iCloud Drive (such as files in your 
Downloads, Movies, and Pictures folders). 
First you set up Back to My Mac on each 
computer, and then you can connect from 
one Mac to the others. Do the following 
on each computer you want to use with 
Back to My Mac:
Choose Apple menu > System Preferences, 
then click iCloud.
Select Back to My Mac.
If you aren’t signed in to iCloud already, 
you must set up iCloud before you can 
select Back to My Mac.
Follow any instructions you see to turn on 
sharing services, select “Wake for network 
access,” or make any other changes 
necessary for Back to My Mac.
To connect to your Mac:

In a Finder sidebar, 
look in the Shared 
section for the Mac 
you want to connect 
to. If nothing is listed 
in the Shared section, 
hold the pointer to the 
right of Shared, then 
click Show.

If you don’t see the Shared heading in the 
sidebar, choose Finder > Preferences, click 
Sidebar, then select Back to My Mac in the 

Shared section.
Click the computer you want to use, then 
click Connect As or Share Screen. (From 
Apple World Today).

2/ Viewing non printing characters in 
word processor documents — Pages has 
a way that you can show and hide what it 
dubs invisible characters, so if you need to 
see paragraph returns, tabs, spaces, and 
so on, it’s as simple as pressing Shift-
Command-I or choosing View > Show 
Invisibles in that program.
Microsoft Word can do this too. If the text 
within a document is behaving oddly, 
figuring out whether something behind 
the scenes is working against you is the 
way to go.
Whenever you hit keys like Tab, Return, 
Spacebar, and so on, Word is actually 
sticking ‘nonprinting characters’ in, 
including ‘page break’.
Turning this view on and off is simple. In 
the most recent version of Word, select 
the Home tab in the toolbar then click 
the giant paragraph sign, which looks of 
like a backwards ‘p.’ It’s a toggle button 
(on or off), so to turn off showing those 
nonprinting characters, press that button 
again.
You can also control which nonprinting 
characters show all of the time, whether 
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you’ve toggled this button on or not. 
That option is available by clicking on 
Word>Preferences from the menus at the 
top of the program. Once the Preferences 
window opens, choose View and you’ll see 
exactly which characters you can choose 
to have showing all of the time (from Mac 
Observer).

3/ Deleting old versions of files — Enter 
the File menu in applications that support 
this macOS feature and choose Revert 
To>Browse All Versions (shown above). 
Navigate to the version of the file that 
you’d like to remove first. Once you’re 
there, move your cursor to the top of the 
screen, and your formerly hidden menu 
bar should reappear. 
Then choose File > Revert To > Delete This 
Version.

4/ Force the Trash to empty — 
Sometimes the Trash refuses to delete a 
file. Quit any app that you were using with 
the file, then try and empty the Trash.
If that doesn’t work, the app might have 
one or more background processes that 
are using the file. Restart your Mac, then 
empty the Trash.

If that doesn’t 
work, you 
might have a 
startup item or 
login item that 
is using the file. 
To temporarily 
prevent such 
items from 
opening 
automatically, 
start up in safe 

mode by holding down the Shift key while 
your Mac starts up. 
Then empty the Trash and restart your 
Mac normally. 
Beyond this, you’ll have to use Recovery 
Mode, which you can read about at Apple 
World Today.

5/ Files as path names — This is verging 
on old school computing’, but from El 
Capitan, Macs have had the ability to copy 
files or folders as pathnames in Finder.

As an example, let’s pretend that you 
wanted to point someone to this file:
/System/Library/WidgetResources/
AppleClasses/Images/slide _ track _
vbottom@2x.png
Look at how long that path is! (Back-
slashes represent folders.) If you were to 
type that out, being sure to get all of the 
capitalisation and so on correct, it’d take 
a while and it would be so easy to get just 
one letter wrong, which stops it working 
(note also that every backslash represents 
a folder – this is the same protocol used in 
web addresses).
The easier way to go is to use a shortcut: 
first, select the file or folder you want to 
copy the pathname for, then press the 
shortcut Option-Command-C, which is 
short for Finder’s Edit>Copy as Pathname 
menu item.
(If you would rather use the Edit menu 
for this, you have to hold down Option in 
order for “Copy as Pathname” to appear 
in the menu itself – as an extra tp, try 
holding down the Option key on your 
keyboard whenever you drop a menu to 
see extra options appear.)
Finally, go to wherever you’d like to put 
in the path, which could be an email, a 
message, or even Terminal, and just press 
Command-V to paste it as you normally 
would.
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> How MacNZ came about (www.mac-nz.com)How&To
What started me off  was Macs
I’m old enough now that the gateway 
drug to Apple was the Mac, rather than an 
iPhone or iPad. Those now-famous Apple 
devices came much later.
I went from managing the production 
of several magazines, all made on 
Macs, to editing a Mac magazine (NZ 
Macguide, 2002-2007). When Macguide 
was withdrawn from the market by its 
publisher, his lack of vision was profound. 
Magbytes went bust because advertisers 
wanted a decent web presence, which he 
refused to understand, and just months 
later he was blindsided by the release 
of the first iPhone, which really raised 
interest in Apple and which probably 
would have saved Macguide.
I founded Mac NZ as Macguide was 
withdrawn, bringing some readers 
with me. Mac NZ’s aim was to carry on 
demystifying Macs, and then iPhones and 
iPads, and went hand-in-hand with the 
Apple help I was offering to individuals, 
groups and institutions. 
As time has gone by, the need for these 
services has diminished. Partly this is 
thanks to Apple’s success – it’s possible to 
find knowledgeable Apple users almost 
anywhere, these days, as there are so 
many Apple users compared to the bad 
old days when Apple was the maverick of 

the computer industry with its little user 
base of loyal creatives. 
Along the way, I got a writing gig for 
the New Zealand Herald online. This 
Apple-centric blog started as a trial but 
was so popular it continued for several 
years, with two columns a week. But 
frustratingly, even though some were 
deemed good enough to be republished in 
the Independent (of London) newspaper, 
the Herald never added my blogs to its 
NZ Herald app, so people were unlikely to 
read it in the likeliest way they might read 
it. (I had even cannily named my column 
‘Apple Watch’ before the Watch was 
introduced.) But eventually, as journalism 
continued its decline, the Herald dropped 
almost all its bloggers.  
Now, most Herald tech news is reprints 
of rumours run by other outlets. For 
example, this torpid crap: ‘iPhone 8 design 
finally revealed’, May 22nd. For no, NZ 
Herald, the design is ‘finally revealed’ when 
Apple finally reveals it, on June 6th our 
time. 

Crossroads
But perhaps I am now at a crossroads. I’ve 
stopped telling people I am available for 
hire to assist them learn and uncover the 
power of their devices. Some just mistook 
me for an Apple-centric IT guy, anyway. 

But more relevant, I had 
to take four days a week 
working at a museum, 
which no mistake, I 
really enjoy. But I need an 
income.  
Almost all I do now its talk to three 
Auckland SeniorNet groups every second 
month, but even this is at a fifth my 
normal group rate. I continue with this 
mostly because it fits in with my museum 
work, and because I really enjoy it. They’re 
a neat bunch of people with fascinating 
stories of their own, and if I can help them 
communicate and get the best from the 
world’s best tech, I am happy to do so. 
That noted, I don’t know whether I can 
afford to, or find the time to, next year. 

So, what do you reckon? 
Do I carry on? I do love learning about 
Apple every day, and I like being able to 
pass that on in digestible form. I would 
like to love Apple as mush as I used to, but 
even I’m feeling the pinch of obsolete Mac 
tech, as fan-boyish as I have consistently 
been. 
But it’s a lonely position, getting up at 
6:30am every day to post missives into the 
ether. At least I know I have lots of readers 
out there – I can see that in my stats. 
I guess that will keep me going.
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> How to use the MacNZ site (www.mac-nz.com)

Remember this is a free service – I run Mac NZ to help people to stay informed. 

The few ads just pay for hosting.

Mac NZ reaches up to 6-10,000 a month people via 

emails, tweets, Facebook, LinkedIn and direct clicks

How&To
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